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Introduction

This guide documents the Silicon Graphics  Audio/Serial Option:

• Chapter 1, “Overview and Theory of Operation” lists the basic
capabilities of the Audio/Serial Option and provides block diagrams of
the board functions.

• Chapter 2, “Using the Serial Ports” describes how to connect devices to
the serial ports, supported baud rates, device file names for the serial
ports, and how to switch the serial ports between RS-232 and RS-422
protocols.

• Chapter 3, “Using Audio” documents how to connect devices to the
audio jacks, how to adjust the input and output audio levels, and how
to use the line-level inputs and outputs in two-channel and
four-channel modes.

• Appendix A, “Connector Pinouts” provides detailed specifications for
the Audio/Serial Option, and documents the board’s connectors and
the signals present on each pin.

This document is designed to give you an overview of using both the serial
ports and the audio capabilities of the Audio/Serial Option. The audio
features and standard serial features of the Audio/Serial Option are
documented in a variety of existing guides and reference pages. The next
section, “Additional Documentation and Information” provides a list of
those sources.
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Additional Documentation and Information

In addition to the Audio/Serial Option User’s Guide, additional information is
available from several different sources.

See the Audio/Serial Option Release Notes for up-to-the-minute information on
the product. Release notes are provided online, and can be viewed using the
following commands:

relnotes A text-based release notes viewer, available by typing
relnotes at a shell prompt.

grelnotes A graphical release notes viewer, which is available from
the Help menu of the Toolchest, or by typing grelnotes at
a shell prompt.

Serial Documentation

For more information about using and configuring serial ports, see the
Personal System Administration Guide, the IRIX Advanced Site and Server
Administrator’s Guide, and the serial(7) reference page.

Note: One section of the Personal System Administration Guide does not apply
to the Audio/Serial Option. The section “Setting Up Peripheral
Connections” describes the Port Tool, which does not work with the
Audio/Serial Option.

For information on writing STREAMS based applications for the
Audio/Serial Option, see asoser(7) and streamio(7). For information on
writing memory-mapped (non STREAMS) applications, see asoserns(7) and
the file /usr/include/sys/asoser.h.
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Audio Documentation

For an overview of the various audio commands, including available online
reference pages, see audio(1).

See the Media Control Panels User’s Guide and the Media Tools User’s Guide for
more information about using audio tools, including making and playing
back recordings and editing sound files.

For information on developing audio applications, see the IRIS  Digital
Media Programming Guide and the Apple® Audio Interchange File Format –
AIFF-C Specification, which are available from Silicon Graphics in the IRIS
Digital Media documentation kit.





This chapter provides an overview of the
Audio/Serial Option, including block
diagrams of the serial and audio portions
of the mezzanine card.
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Chapter 1

1. Overview and Theory of Operation

This Chapter provides an overview of the Audio/Serial Option, describing
the various connectors and basic functions.

Description

The Audio/Serial Option provides the following capabilities:

• Audio Library-compatible audio input and output.

• Audio capabilities that are functionally equivalent to those provided on
the Indigo2 and Indy, including dedicated line-level in and out, serial
digital audio in and out, headphone output, and microphone input.

• Line-level audio input and output in either two-channel mode or
four-channel mode.

• Six serial ports, switchable through software between RS-422 and
RS-232.

• Serial port speeds of up to 38400 baud using standard utilities (such as
getty and cu) and up to 115,200 baud through user-developed
applications. User-developed applications can use either STREAMS or,
for lower latency, memory-mapped I/O.

Caution: Although the Audio/Serial Option serial ports can function at
speeds beyond 115,200 baud, such higher rates are not supported. Operating
beyond 115,200 baud can result in loss of serial characters and overall
degraded performance.
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Block Diagram of the Audio/Serial Option

Figure 1-1 is a block diagram of the Audio/Serial Option board, showing the
serial subsystem and its relation to the audio subsystem.
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Figure 1-1 Block Diagram of the Audio/Serial Option
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Serial Subsystem

The serial subsystem provides six DB-9 female serial connectors, each of
which are selectable in software between RS-232 and RS-422 modes.
Figure 1-2 shows how the ports are arranged on the connector plate.

Figure 1-2 Layout of the Serial Connectors

For a description of the pin-outs of the serial connectors, see Appendix A,
“Connector Pinouts.”

Note: In RS-422 mode, the pin-outs of the Audio/Serial Option ports do not
match those of the built-in RS-422 connector on CHALLENGETM and
OnyxTM deskside and rackmount systems. See “Differences Between
Existing Challenge and Onyx Serial Ports” on page 23.
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Table 1-1 shows how the ports correspond to tty device files.

Audio Subsystem

The audio subsystem provides the following inputs and outputs:

• Headphone output (stereo)

• Microphone input (mono or stereo)

• Line-level input

• Line-level output

• Serial digital input/output

For detailed electrical specifications, impedances, and output levels, see
“Audio Specifications” in Chapter 3.

Table 1-1 Correspondence of Serial Ports to Device File Names

RS-232 Device File RS-422 Device File Memory-Mapped Device File

/dev/tty[dfm]72 /dev/tty4[dfm]72 /dev/aso_mmap/tty72

/dev/tty[dfm]73 /dev/tty4[dfm]73 /dev/aso_mmap/tty73

/dev/tty[dfm]74 /dev/tty4[dfm]74 /dev/aso_mmap/tty74

/dev/tty[dfm]75 /dev/tty4[dfm]75 /dev/aso_mmap/tty75

/dev/tty[dfm]76 /dev/tty4[dfm]76 /dev/aso_mmap/tty76

/dev/tty[dfm]77 /dev/tty4[dfm]77 /dev/aso_mmap/tty77
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All the audio jacks accept 3.5-mm stereo plugs, which can use mono plugs
where appropriate. Figure 1-3 shows the layout of the audio connectors.

Figure 1-3 Audio Connectors
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Block Diagram and Features

The heart of the Audio/Serial Option audio subsystem is the HAL2, a
high-density ASIC on the audio module that performs the basic I/O
functions. Figure 1-4 is a block diagram of the audio subsystem.
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Figure 1-4 Block Diagram of the Audio Subsystem
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The audio module provides the following features:

• Stereo line-level analog audio input and output.

• Stereo headphone output.

• Microphone input that supports stereo and mono microphones.

• Serial digital audio input and output, supporting up to 24 bits per
sample.

• Industry-standard sampling rates of 8, 11.025, 22.5, 16, 32, 44.1, and 48
kHz, and others.

• Microphone input with DC power.

• Simultaneous input and output.

• Independent input and output sampling rates.

• Output rate can be synchronized to the serial digital audio input rate.

• Silicon Graphics Audio Library (AL) application programming
interface (API).

• Low-latency operation.

• Four-channel mode supports four-analog-channel input and
four-analog-channel output, simultaneously.

• Analog audio input may be synchronized to serial digital audio input
rate.

• Sampling time base is generated by Bresenham's algorithm, allowing
near-continuous choice of sample rates.
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HAL2 ASIC

The audio module is built around a central controller chip, the HAL2 ASIC,
two audio CODEC chips, an AES transmitter chip, an AES receiver chip, a
microphone input circuit, a headphone amplifier circuit, and a four-channel
mode switching relay.

The HAL2 chip is a 1-micron, 28K-gate, CMOS gate array that contains the
data path and control logic to interface the P-bus and the audio devices on
the module. The major functional blocks connected to the HAL2 are the two
CS4216 CODECs, the CS8401 AES3 transmitter, the CS8411 AES3 receiver,
the headphone gain circuit, the microphone input circuit, and the
four-channel mode switching relay.

Notable features of the HAL2 design:

• Three independent clock sources:

– AES out

– analog in

– analog out

• Each of the clock generators can select from three different time bases:

– 44.1 kHz master clock

– 48 kHz master clock

– AES3 external clock (through the serial digital jack)

• The clock generators scale the input clocks by rational fractions.

• Each audio device has its own DMA channel and clock generator.

• The audio devices attach with conventional three-wire serial interfaces.

• In four-channel mode, each four-channel DMA data stream consists of
interleaved, synchronized audio data.
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CODECs

The audio module uses a pair of Crystal Semiconductor CS4216 stereo audio
coder/decoders (CODECs). These chips are monolithic CMOS mixed-signal
devices. Both of the Analog-to-Digital Converters (ADC) and
Digital-to-Analog Converters (DAC) are 64x-oversampling delta-sigma
16-bit converters. They also contain on-chip reconstruction and anti-aliasing
filters, programmable input gain, and programmable input source
switching. The filter responses track the sampling rate, a significant
advantage over the older fixed-response, low-pass, analog filter designs.

In the normal mode of operation, the CODEC A DAC is used for analog
output and the CODEC B ADC is used for analog input. The CODECs can
use independent sample-rate clock generators from the HAL2 so that the
analog input sample rate and the analog output sample rate may be selected
independently. The analog input (to CODEC B) is selectable from either the
line or microphone inputs under software control. The analog output signal
(from CODEC A) is routed both to line-out and to the stereo headphone
circuit.

The audio system provides an enhanced mode of operation that extends
from two to four the number of simultaneously active analog input
channels. The graphical audio control panel utility, apanel, can switch the
audio system between two-channel mode and enhanced, four-channel
mode. This can also be done programmatically by applications.

In enhanced, four-channel mode, both CODECs are synchronized to the
same sample rate and are used simultaneously for input (ADC) and output
(DAC). CODEC B’s input (ADC) comes from the microphone input, while
CODEC A’s input (ADC) comes from the line input. CODEC A’s output
continues to be routed to the line output, but CODEC B’s output is routed at
line-levels to the headphone jack.
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Powered (Headphone) Output

The audio module provides a 3.5-mm stereo phone jack for a set of
headphones. See “Audio Specifications” in Chapter 3 for output power
ratings and other characteristics, and Appendix A, “Connector Pinouts,” for
the tip-ring-sleeve connections.

In four-channel mode, the headphone output is switched to line-level
output.

Microphone Input

The microphone input is a 3.5-mm stereo phone jack that accepts mono or
stereo signals. See “Audio Specifications” in Chapter 3 for information on
input sensitivity and other characteristics, and Appendix A, “Connector
Pinouts,” for a description of the tip-ring-sleeve connections.

In four-channel mode, the microphone input can be used either for
microphone-level signals or switched to line-level input.



This chapter explains how to use the
serial ports and discusses various issues
pertaining to their use and
programming.

Using the Serial Ports

Chapter 2
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Chapter 2

2. Using the Serial Ports

This Chapter describes how to use the serial capabilities of the serial/audio
mezzanine card. For information on writing applications, see “Additional
Documentation and Information” on page x.

Required Software

In order to use the serial ports, the Audio/Serial Option requires the aso.sw.
subsystem, which provides:

• the STREAMS based ASO driver (/var/sysgen/boot/asoser.o), which lets
you use the serial ports on the Audio/Serial Option with STREAMS
based utilities at up to 115,200 baud (depending upon the utility)

• the memory-mapped ASO driver (/var/sysgen/boot/asoserns.o), which
allows custom applications to use a low-latency, memory-mapped
interface to the ASO serial ports

Attaching Serial Devices

All of the serial ports provided by the Audio/Serial Option use DB-9
connectors and can be used as either RS-232 or RS-422 ports. When used as
RS-422 ports, pins 1 and 6 are activated for TX_H and RX_H (transmit high
and receive high), respectively. See Appendix A, “Connector Pinouts,” for a
diagram of the connector pinout of the DB-9 ports.

Caution: The power-up default for all of the Audio/Serial Option serial
ports is RS-232 mode. If you have serial devices that would be damaged by
pinout voltages in RS-232 mode, be sure to disconnect them before rebooting
your Challenge or Onyx system.
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Correspondence of Ports and Device Entries

Figure 2-1 shows the layout of the serial ports.

Figure 2-1 Layout of Serial Ports

Pinouts for the ports are described in Appendix A, “Connector Pinouts.”
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Table 2-1 shows how the ports correspond to IRIX  device file entries.

Testing A Serial Port

To make sure that a particular serial port is working in RS-232 mode, follow
these steps:

1. Obtain an ASCII terminal and the proper cable with which to connect it
to one of the Audio/Serial Option serial ports:

■ The ports on both the Audio/Serial Option and the terminal use
data terminal equipment (DTE) signals. This means the transmit
data pin on an Audio/Serial Option port should be connected to a
receive data pin on the terminal, and vice versa. See Appendix A,
“Connector Pinouts.”

■ The cable needs at least three wires to function properly with a
terminal: transmit low (pin 2), receive low (pin 3), and ground (pin
7). (These pin numbers are for the Audio/Serial Option DB-9
connector; the pin numbers on the terminal may vary, depending
upon the type of connector it uses.)

2. Connect the ASCII terminal to the serial port you want to test using the
serial cable.

Table 2-1 How the Serial Ports Correspond to IRIX Device Files

RS-232 Device RS-422 Device High-Speed (Memory-Mapped) Device

/dev/tty[dfm]72 /dev/tty4[dfm]72 /dev/aso_mmap/tty72

/dev/tty[dfm]73 /dev/tty4[dfm]73 /dev/aso_mmap/tty73

/dev/tty[dfm]74 /dev/tty4[dfm]74 /dev/aso_mmap/tty74

/dev/tty[dfm]75 /dev/tty4[dfm]75 /dev/aso_mmap/tty75

/dev/tty[dfm]76 /dev/tty4[dfm]76 /dev/aso_mmap/tty76

/dev/tty[dfm]77 /dev/tty4[dfm]77 /dev/aso_mmap/tty77
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3. Turn on the terminal and make sure it is configured in the following
way:

■ 9600 baud

■ 8 data bits

■ 1 stop bit

■ no parity

4. Press the <Enter> key on the ASCII terminal. You should see a login
prompt similar to this:

IRIS login:

5. If you do not see a login prompt, log in as root on the workstation and
type some characters directly to the terminal.

6. For example, if you are testing the port tty_72, type the following at a
shell prompt:

cat >> /dev/ttyd72
This is a test
Are these words displayed
on the terminal screen?

These sentences should appear on the ASCII terminal. When you are
finished typing, press <Ctrl-D>.

7. If you do not see a login prompt, and the sentences you typed in the
previous step do not appear on the ASCII terminal screen, check the
following:

■ Make sure the cable is connected to the correct serial port. Refer to
Figure 2-1 for the default layout of serial ports and connectors.

■ Make sure the cable is wired correctly. It should be a three-wire,
null-modem serial cable with transmit wired to receive, and
ground wired to ground.

■ Verify that the terminal’s communication settings are correct. They
should be 9600 baud, 8 data bits, 1 stop bit, and no parity.
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■ Some terminals have more than one port (for example, a data port
and an auxiliary port.) Make sure you connect the serial cable to the
correct port for the terminal, usually the port labeled Data or
Modem. If your terminal has more than one port, and you are not
sure which is correct, refer to your terminal’s documentation.

For complete information on using serial ports with modems, terminals, and
other devices, see the IRIX Advanced Site and Server Administrator’s Guide.

Serial Modes and Baud Rates

Table 2-2 shows how you can use any of the six ASO serial ports:

Caution: When the serial ports on the Audio/Serial Option are used in
RS-422 mode, the pin-outs are not the same as the standard RS-422 ports
used on Challenge and Onyx deskside and rackmount systems. See
“Differences Between Existing Challenge and Onyx Serial Ports” on page 23.

a. Standard utilities, such as getty and cu, may be limited to 38400 baud. Using serial devices
via STREAMS at greater than 38400 baud requires custom applications.

b. Software selectable; the default is RS-232.

Table 2-2 ASO Serial Port Device Entries and Baud Rates

Serial Mode Device Files Maximum
Baud
Rate

Driver

RS-232 /dev/tty[dfm]72
through
/dev/tty[dfm]77

115,200a Silicon Graphics supplied
ASO driver
/var/sysgen/boot/asoser.o

RS-422 /dev/tty4[dfm]72
through
/dev/tty4[dfm]77

115,200a Silicon Graphics supplied
ASO driver
/var/sysgen/boot/asoser.o

RS-232 or
RS-422 via
memory-
mapped
interfaceb

/dev/aso_mmap/tty72
through
/dev/aso_mmap/tty77

115,200a Silicon Graphics supplied
ASO driver
/var/sysgen/boot/asoserns.o



22

Chapter 2: Using the Serial Ports

If you access the serial ports through the entries /dev/tty[dfm]72 through
/dev/tty[dfm]77, RS-232 signals are automatically enabled on the serial port
pins. If you access the ports through the entries /dev/tty4[dfm]72 through
/dev/tty4[dfm]77, RS-422 signals are automatically enabled. You can also
select between RS-232 and RS-422 modes using STREAMS IOCTL calls. See
the serial(7), streamio(7), and asoser(7) reference pages, and
/usr/include/sys/asoser.h.

Memory-mapped applications use /dev/aso_mmap/tty72 through
/dev/aso_mmap/tty77. Both RS-232 and RS-422 modes are supported. The
default is RS-232. See the asoserns(7) reference page.

Standard IRIX serial utilities may not work at baud rates higher than 38400.
Custom applications can use baud rates up to the maximum supported by
the Audio/Serial Option using either STREAMS or memory-mapping. See
“Writing Serial Applications” on page 24 for more information.

Setting Up Serial Ports for Use With IRIX

To use the Audio/Serial Option serial ports with standard utilities,
operations, and devices, such as getty, cu, SLIP, PPP, uucp, printers, terminals,
and modems, you must manually edit a variety of configuration files. For
complete instructions, see the IRIX Advanced Site and Server Administrator’s
Guide. Also, see serial(7) and the reference pages for the specific utilities, such
as getty(1M).

The IRIX Advanced Site and Server Administrator’s Guide is available online
using the InSight document viewer. It is also available in printed form.
Contact your local Silicon Graphics representative for more information on
ordering printed manuals.

Note: Do not use the graphical Port Setup tool, available from the Toolchest
and System Manager, with the Audio/Serial Option. This is the tool that is
documented in “Setting Up Peripheral Connections,” in the Personal System
Administration Guide. The Port Setup tool does not recognize the serial ports
found on the Audio/Serial Option.
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Differences Between Existing Challenge and Onyx Serial Ports

In RS-232 mode, the pin-outs of the Audio/Serial Option serial ports are
identical to the standard RS-232 ports found on Challenge and Onyx
systems. However, the serial ports on the Audio/Serial Option use different
pinouts for RS-422 connections. Table 2-3 shows these differences between
the ports:

If necessary, you can use the information in the above table to construct an
adapter cable that will allow any RS-422 cables designed for the existing
Challenge and Onyx port pinouts to work properly with the Audio/Serial
Option ports.

Table 2-3 RS-422 Port Pinout Comparison

Audio/Serial Option
Port Pin Number

Existing CHALLENGE and
Onyx Port Pin Number

Meaning

1 7 Transmit high (TX_H)

2 2 Transmit low (TX_L)

3 3 Receive low (RX_L)

4 9 Request to send (RTS)

5 5 Clear to send (CTS)

6 8 Receive high (RX_H)

7 6 Signal ground

8 4 Data carrier detect (DCD)

9 1 Data terminal ready
(DTR)
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Writing Serial Applications

The Audio/Serial Option provides two methods of accessing serial devices:

• a STREAMS based interface

• a memory-mapped interface

The following guidelines should help application developers decide which
method to use.

The STREAMS interface is appropriate if you want to take advantage of the
features of STREAMS. These features include portability, carriage-return
and newline translation, blocking I/O, and ease of porting existing
STREAMS based serial applications.

However, the memory-mapped interface may be appropriate for the
following reasons:

• It offers lower latency than STREAMS, making it more appropriate for
use with the frame scheduler in real-time applications.

• It offers lower system overhead.

• It provides non-blocking I/O, which may be important for applications
that need a smooth flow of data to and from a serial device.

See “Additional Documentation and Information” on page x for information
on STREAMS documentation.
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Tuning Serial Performance

One way that you can tune serial performance is through the lboot variable
asoser_int_lim, which is found in the file /var/sysgen/master.d/asoser. This
variable controls the maximum number of interrupts per second generated
by the Audio/Serial Option board.

Values of asoser_int_lim range from 50 to 1000 interrupts per second. A lower
number of interrupts per second causes greater latency for serial I/O. A
higher number of interrupts increases interrupt overhead and thus CPU use.
The default value of asoser_int_lim is 500.

When using the memory-mapped interface, latency is the expected time
between the receipt of the “stop” bit trailing a the data byte and the time that
data byte becomes is available to the user application. When using the
STREAMS driver, latency can be longer because of STREAMS scheduling. If
low-latency is important for a particular application, use the non STREAMS
(memory-mapped) driver.

Latency can also vary slightly under severe system bus loading or is
interrupts are disabled for a long period of time. To help prevent data loss
under these conditions, the Audio/Serial Option mezzanine card and
firmware are designed to buffer thousands of characters.

The formula in Figure 2-2 describes how the number of interrupts per
second (IPS) translates into latency in milliseconds.

Figure 2-2 Computing Serial I/O Latency From Serial Interrupts

Thus, an asoser_int_lim value of 50 interrupts per second would translate to
a latency of 20 milliseconds.

=
1

IPS
x 1000 + 1 Latency in milliseconds
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It also contains electrical and
performance specifications for the audio
subsystem.
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3. Using Audio

This Chapter describes how to use the audio capabilities of the Audio/Serial
Option.

Required Software

There are a variety of utilities supplied by Silicon Graphics that let you
manipulate the audio ports, work with audio files, bring audio signals into
the system, and send audio signals out of the system. These include:

apanel A graphical control panel that manipulates the input signal
levels and headphone output level, and switches between
two-channel and four-channel audio modes.

soundplayer A graphical tool for playing audio files.

soundeditor A graphical tool for editing mono and stereo audio files.

sfinfo A command-line tool that describes the format of an audio
file.

sfplay A command-line tool for playing audio files.

These and other audio tools are found in the various dmedia_eoe and
dmedia_tools subsystems. For an overview of the various audio tools and
the audio hardware, see the audio(1) reference page, the Media Tools User’s
Guide, and the Media Control Panels User’s Guide.

Developing Audio Applications

The Audio Library (AL) programming interface provides an application
programming interface for developing audio applications. The Audio
Library is provided in the IRIS Development System option. The Audio
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Library is documented in the IRIS Digital Media Programming Guide. This
guide, as well as the Apple® Audio Interchange File Format – AIFF-C
Specification, are available from Silicon Graphics in the IRIS Digital Media
documentation kit. Also, the various audio library calls, for example
AFclosefile(3dm), are documented in the digital media reference pages
(section 3dm).

Using the Software Audio Control Panel

The graphical utility that controls audio on a Silicon Graphics workstation is
the audio control panel, or apanel. You can start apanel from the Toolchest, by
opening the apanel desktop icon, or by typing apanel at a shell prompt.
Many utilities, such as capture and soundeditor, also provide the ability to start
apanel. When you start apanel from the command line, a variety of options are
available. See apanel(1).

Figure 3-1 shows apanel in the default, two-channel mode.

Figure 3-1 The Audio Control Panel (Two-Channel Mode)
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The audio control panel shows you the state of the audio hardware and
allows you to control input levels, input and output sampling rates, and
headphone output. You can also monitor both the signal and signal levels of
a given input.

Although the output sliders are labeled “Speaker,” there is no external
speaker provided with the Audio/Serial Option. The output sliders control
the headphone volume.

Note: The input meters consume some CPU bandwidth and use one of the
internal audio ports.

Selecting the Sampling Rate

To select the input or output sampling rates, pull down the Rate menu and
select either Input or Output, then choose the appropriate rate. Figure 3-2
shows the Input sampling rate menu.

Figure 3-2 Changing the Sampling Rate (Input Shown)
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The Output rate sampling menu has the additional option of matching the
Input sampling rate regardless of what the Input sampling setting. This is
useful because apanel is not a sampling rate conversion tool. If the input and
output rates do not match, the resulting audio signal is pitch-shifted and
distorted.

Sampling-rate conversion is performed by the graphical tool soundfiler and
by the command-line tool sfconvert. See audio(1) for an overview of the
various tools.

Be aware that audio applications will change the sampling rates as needed
and there is no way to “lock” the sampling rate so that this does not happen.
Many applications return the sampling rate to the previous setting, but some
applications do not.

Using the Sliders for Independent Left and Right Levels

By default, the left and right sliders of both the input and output controls are
ganged together. If you want independent control over the sliders, select the
Options menu and click on the check box that corresponds to the sliders you
want to control. Figure 3-3 shows the Options menu.
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Figure 3-3 The Audio Panel Options Menu

Two-Channel Mode Input and Output

In two-channel mode, you can select from one of the three input channels
using the Input pulldown menu. Available input channels are digital I/O,
line-level input, and microphone input.

You can switch the microphone input between mono and stereo modes
using the Options menu.

To adjust the headphone volume, use the output sliders.

The line-level output, and digital I/O signal levels are not adjustable.
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If you want to see the signal level of a sound file that you are playing (for
example, using playaifc or soundeditor), switch the input mode to Digital. This
causes the meters to display the signal level of the sound file as it plays,
provided:

• the output sampling rate is not set to “input rate,”

• the sampling rate of the audio file you are playing is 30 kHz or greater,
and

• there is no plug installed in the serial digital audio jack.

Do not turn on monitoring (by checking the Monitor box) while listening to
a sound file, as this will cause feedback.

Four-Channel Mode Input and Output

In four-channel mode, the microphone and headphone jacks have different
functions than in normal, stereo mode in order to provide four-channel,
line-level input and output. Table 3-1 shows the function of each connector
in four-channel mode.

Table 3-1 Input and Output Assignments in Four-Channel Mode

Input Selection Connector Function

Microphone Digital
Headphone
Line-level output
Line-level input
Microphone input

N/A
Line-level output (L2)
Line-level output (L1)
Line-level input (L1)
Microphone input (L2)

Line Digital
Headphone
Line-level output
Line-level input
Microphone input

N/A
Line-level output (L2)
Line-level output (L1)
Line-level input (L1)
Line-level input (L2)

Digital Digital
Headphone
Line-level output
Line-level input
Microphone input

Digital In/Out (L1)
Line-level output (L2)
Line-level output (L1)
N/A
N/A
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Changing the Audio Panel Input Scale

You can switch the input scale between simple 1 to 10 gradations and decibel
calibrations by running apanel with either the -decadescale or -dbscale
options. See apanel(1) for more information.

Saving and Loading Audio Panel Configurations

You can save and load audio panel configurations through the File menu.
Select the Save option to save the current apanel configuration in the default
filename (apanel.parameters) in your home directory. The Save As option
prompts for an alternate file name.

To load a configuration, select Open from the File menu.

Audio panel configurations are not automatically loaded when apanel starts.
You have to specifically open a file that contains audio panel configuration
settings.
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Attaching Audio Cables

All of the audio connectors accept 3.5-mm stereo phone plugs. The following
connectors use stereo (L, R, and ground) connectors:

• Line in

• Line out

• Serial digital audio

• Headphone

The microphone connector accepts either mono or stereo plugs, depending
upon the application and how the connector is configured
(programmatically or through apanel).

For a complete description of the tip, ring, and sleeve connections for all of
these jacks, see Appendix A, “Connector Pinouts.”

Connector Size Limitations

The audio connector bodies and strain-relief attachments cannot be longer
than about 1.75 inches to 2 inches (4.4 cm to 5 cm). The exact length depends
upon where the audio connector housing is installed, which jack you are
using, and the flexibility of the audio cable you are attaching. Also,
rackmount systems will typically provide greater clearance and deskside
systems for connector housings. See Figure 3-4.
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Figure 3-4 Audio Cable Connector-Body Limitations

1.75" (4.4 cm
      to
2 " (5 cm) 
maximum
clearance
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To avoid damaging the audio cables and connectors, use right-angle audio
connectors whenever possible.

Warning: Do not operate a Challenge or Onyx system with the door
open or removed. The door channels air for proper flow through the
system and protects connectors and back-panel components from
accidental damage. If an audio connector does not allow the door to close
properly, you should obtain a right-angle connector or other adapter cable
to allow you to close the system door.

Digital Transfers

Serial digital transfers can be made for any sampling rate between 30 kHz
and 50 kHz. If you want to use other sampling rates, you must use the analog
interconnect (line-level).

Audio Techniques

The following are some techniques that are useful for obtaining the best
possible signals with the Audio/Serial Option.

Equipment and Connections

Avoid using mono plugs in the stereo connectors, or cables that short some
of the signals together. Avoid using cables with built-in attenuation.

Minimizing Input Gain/Maximizing Input Signal

The analog input circuitry for microphone and line-in recording has a
software-controlled gain setting. The input circuitry accommodates signal
levels of up to 8.4 Vpp (peak-to-peak) at the line-in connector. This is in
excess of the levels produced at most modern consumer equipment line-out
connectors.

To produce the best possible recordings, turn up the output control as far as
possible without exceeding 8.4 Vpp (if the source machine has an output
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control). Start with the apanel input gain level setting at the “factory preset”
level, which corresponds to “8” on the scale. Adjust the input gain level
setting so that loudness peaks of the input material lights up almost the
entire level meter. You can obtain the best results with a low input gain
setting and a signal that registers nearly the entire span of the meter.

Minimizing Output-to-Input Crosstalk

In order to minimize distortion and crosstalk effects between the headphone
amplifiers and the more sensitive portions of the analog audio system,
reduce the headphone volume level as much as possible during critical
analog recording. Changing the headphone volume does not affect the
line-out levels.

Avoiding Ground Loops

The analog audio instrumentation circuits in the Audio/Serial Option are
very sensitive to the implementation of an analog ground voltage reference.
You can achieve the best performance by letting the workstation be the only
machine in your system of audio equipment that connects its system
electrical ground to the safety grounding conductor.

If this is not possible, you may have to use signal isolation transformers.
Note that the serial digital audio ports are already isolated by transformers
within the machine, so that ground-reference problems do not typically
apply to serial digital audio connections.

Other Cautions and Advice

If your workstation is connected to a monitoring system such as a power
amplifier driving speakers or headphones, turn the monitoring system
volume down or off before you power the workstation on or off.

Do not wear headphones that are plugged into the workstation during
power on or off cycles.
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Do not record or monitor from an input connector that has nothing plugged
into it.

Never connect a high-power output, such as the speaker output of a power
amplifier, to any of the audio connectors on the Audio/Serial Option.

Audio Specifications

This section describes the electrical and performance specifications of the
audio subsystem. Unless otherwise stated, all parameters given in the
following sections are measured under the conditions shown in Table 3-2:

Serial Digital Interconnect Standards and Specifications

The Stereo Serial Digital Audio interconnect is a coaxial digital interconnect
that makes noiseless audio connections to DAT machines, professional
audio equipment, CD players, other workstations, and so forth. It
corresponds to the electrical characteristics of AES3-ID-DRAFT, for
distribution of digital audio using 75-ohm video cable. The interconnect is
transformer coupled to prevent ground loops and provide isolation.

Table 3-2 Audio Subsystem Specifications Test Conditions

Specification Test Condition

Analog test signal levels

     Line-level input

     Microphone input

1 Vrms

0.1 Vrms

Analog test signal output impedance 600 Ω

Test output destination impedances

     Line-level output

     Headphone output

5 kΩ
150 Ω

Sampling rate 48 kHz

Measurement bandwidth 17 Hz to 22 kHz, unweighted

Digital test signal level 100% of full scale
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It supports up to 24-bit, 50 kHz sampling. It is based on the following
standards:

• CP-340: EIAJ

• AES3-1992: Audio Engineering Society

• AES3-ID-DRAFT: Audio Engineering Society

• IEC958: IEC

The sample rate is encoded in the incoming stream, and the input sample
rate may serve as sample clock source for analog in, analog out, and digital
out. The digital output is nominally set to consumer-level configuration.

Table 3-3 lists the specifications for the serial digital audio input and output:

Table 3-3 Serial Digital Specifications

Specification Value

Input impedance 75 Ω, transformer coupled

Input level 0.5 Vpp nominal

Input sample rates 30 kHz to 50 kHz

Output impedance 75 Ω, transformer coupled

Output level 0.5 Vpp into 75 Ω load

Output sampling rates 32 kHz, 44.1 kHz, 48 kHz serial input
sampling rate and divisors of those rates

Resolution Supports up to 24 bits per sample
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Line-Level Input and Output Specifications

Table 3-4 lists the specifications for the line-level input.

Table 3-5 lists the specifications for the line-level output:

Table 3-4 Line-Level Input Specifications

Specification Value

Impedance 20 kΩ, nominal

Frequency response +/– 0.81 dB, 20 Hz to 20 kHz

Total harmonic distortion + noise

     At 1 kHz

     Maximum

< 0.006%, 20 Hz to 20 kHz

< 0.007%

Residual noise, unweighted –86 dB

Residual noise, A weighted –88 dB

Interchannel isolation

     1 kHz

     10 kHz

     20 kHz

–82 dB

–72 dB

–67 dB

Full-scale amplitude 0.63 Vpp to 8.4 Vpp

Gain adjustment increment 1.5 dB

Gain range 0 dB to +25 dB

Table 3-5 Line-Level Output Specifications

Specification Value

Impedance 600 Ω, nominal

Frequency response +/– 1.2 dB, 20 Hz to 20 kHz

Total harmonic distortion + noise

     At 1 kHz < 0.02%, 20 Hz to 20 kHz

Residual noise, unweighted –81 dB
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Microphone Input Specifications

Table 3-6 lists the specifications for the microphone input:

Residual noise, A weighted –85 dB

Interchannel isolation

     1 kHz

     10 kHz

     20 kHz

–80 dB

–75 dB

–71 dB

Full-scale amplitude 4.7 Vpp

Table 3-6 Microphone Input Specifications

Specification Value

Input impedance 1.5 kΩ

Frequency response +/– 0.66 dB, 20 Hz to 20 kHz

Total harmonic distortion + noise

     At 1 kHz

     Maximum (at 17.5 kHz)

< 0.0053%, 20 Hz to 20 kHz

0.0067%

Residual noise, unweighted –86 dB

Residual noise, A weighted –89 dB

Full-scale amplitude 0.063 Vpp to 0.84 Vpp

Microphone power supply +3 VDC, 1 mA maximum

Table 3-5 (continued) Line-Level Output Specifications

Specification Value
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Headphone Output Specifications

Table 3-7 lists the headphone output specifications:

Table 3-7 Headphone Output Specifications

Specification Value

Headphone output level

     Into a 64 Ω load

     Into a 32 Ω
     Into a 16 Ω load

36 mW

57 mW

74 mW

Impedance 10 Ω

Frequency response +/– 2.3 dB, 20 Hz to 20 kHz

Total harmonic distortion + noise

     At 1 kHz

     Maximum (at 19.3 kHz)

< 0.2%, 20 Hz to 20 kHz

0.3%

Residual noise, unweighted –88 dB

Residual noise, A weighted –90 dB

Interchannel isolation

     1 kHz

     10 kHz

     20 kHz

–87 dB

–76 dB

–73 dB



This appendix documents the pin
assignments of the external connectors of
the Audio/Serial Option.

Connector Pinouts

Appendix A
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A. Connector Pinouts

This Appendix describes the pinouts of the various connectors on the
Audio/Serial Option mezzanine card.

Serial Ports

The Audio/Serial Option serial ports are female DB-9 connectors.
Figure A-1 shows the pin numbering of the connectors.

Figure A-1 Serial Port Pin Numbering

1

2
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4

5

6

7

9

8
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Table A-1 describes the pinouts of the DB-9 connectors in both RS-232 and
RS-422 modes.

Audio Connectors

All audio jacks accept 3.5 mm stereo phone plugs. The microphone input can
be used with a mono plug for mono input signals. Other inputs can be used
with mono plug, which short the ring signal to ground.

Table A-2 lists the tip, ring, and sleeve connections for the various audio
connectors.

Table A-1 Audio/Serial Option Serial Connector Pinouts

Pin Number RS-232 Mode RS-422 Mode

1 N/C Transmit high (TX_H)

2 Transmit low (TX_L) Transmit low (TX_L)

3 Receive low (RX_L) Receive low (RX_L)

4 Request to send (RTS) Request to send (RTS)

5 Clear to send (CTS) Clear to send (CTS)

6 N/C Receive high (RX_H)

7 Signal ground Signal ground

8 Data carrier detect (DCD) Data carrier detect (DCD)

9 Data terminal ready (DTR) Data terminal ready (DTR)

Table A-2 Audio Connector Tip, Ring, and Sleeve Assignments

Connector Tip Ring Sleeve

Microphone Input (mono)
Left (stereo)

N/C (mono)
Right (stereo)

Ground
Ground

Line-level input Left Right Ground

Line-level output Left Right Ground
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Headphone Left Right Ground

Digital I/O Output Input Ground (for this
circuit only;
isolated from
analog audio
ground)

Table A-2 (continued) Audio Connector Tip, Ring, and Sleeve Assignments

Connector Tip Ring Sleeve
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